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An archaeological earthwork survey by LiDAR study for land off MIRA, 
Higham on the Hill, Leicestershire    

 
 
M. Beamish 
 

Summary 
An archaeological earthwork survey by LiDAR study has been prepared for 
Swanvale Developments on behalf of HORIBA MIRA Ltd by University of Leicester 
Archaeological Services (ULAS) for land to the west of MIRA, Higham on the Hill, 
Leicestershire (SP 7470 8870). The survey was undertaken in advance of the 
proposed development of the site.   
Earthwork survival across the area is generally poor. Some pieces of evidence are 
used to identify previous land-uses. Features that can be identified can mostly be 
matched in historic mapping or aerial photographs. The broad topography of the 
area is discussed and its relationship with the registered battlefield of Bosworth 
Field.  
This study has been preceded by a desk-based assessment, a geophysical survey and 
a fieldwalking survey (Hunt 2018; Gater 2018, Gonzalez Rodriquez 2018 
respectively, while the results of a metal detector survey are in preparation 

 
 

1. Introduction 
 
In accordance with National Planning Policy Framework (NPPF), Section 12 (Conserving and 
Enhancing the Historic Environment) this document is an Archaeological desk-based 
assessment for land at MIRA, Higham on the Hill Leicestershire (SP74717 88687). 

The assessment was commissioned by Langton Developments from University of Leicester 
Archaeological Services (ULAS) in connection with a proposed planning application for 
residential development of the site. 

The LiDAR study has been commissioned with the aim of enabling clear assessment of the 
extent and character of any earthwork features within and immediately adjacent to the site.  
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 Figure 1: Site Location  
Contains OS data © Crown copyright [and database right] 2018 
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2. Site Description, Topography and Geology 
The MIRA site lies within the parish of Higham-on-the-Hill, in the District of Hinckley and 
Bosworth, Leicestershire, around 5 miles north-west of Hinckley and 3.5 miles north-east of 
Nuneaton (Figure 1). It is bordered by the A5 (Roman Watling Street) to the south; which is 
the border with Warwickshire. The dismantled Ashby and Nuneaton Joint Railway runs to the 
south-east of the site and to the north-west and north-east lie fields and local roads. The 
proposal area lies on fields at the north-western edge of the area. The northern part of these 
fields lie within Witherley parish. 

The site lies at a height of around 100m aOD, with the high point of the site lying at 104m aOD 
close to the southern edge. The total area of the MIRA site is around 310ha. The TIC-IT site 
covers around 33.7 hectares. 

The British Geological Survey website indicates that the underlying geology across most of 
the site consists of Thrussington Member Diamicton overlying Mercia Mudstone, with Mercia 
Mudstone to the south and some areas of Bosworth Clay Member overlying Mercia Mudstone 
over most of the TIC-IT site. An area of alluvium is mapped in the northern part of the area. 

The broad topography is generally flat with little undulation. Slightly more elevated ground 
forms a low broad north-south ridge to the west of the proposed area (at the apex of which a 
mound is located MLE3297) while Higham on the Hill clearly occupies high ground to the 
south (Figure 5). Contours have been generated from the LiDAR data (Figure 17).  

 
 



Land at MIRA, Higham on the Hill  Report 2018-054 

© ULAS 2018   4 

 

Figure 2: Geology 
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Figure 3: Monuments (Roman and earlier) 
Contains OS data © Crown copyright [and database right] 2018 
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Figure 4: Monuments (Medieval and later) and findspots from metal detector survey in 
adjacent fields.  

Contains OS data © Crown copyright [and database right] 2018   
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3. Historical and Archaeological Background  
A desk based assessment has been compiled (Hunt 2018). The proposed area lies to the west 
of the current MIRA vehicle testing facility, which itself lies upon a former WWII airfield. The 
proposed new development site lies within pasture and arable fields, except for a section that 
was once the dispersal point for aircraft and is covered in hard standing and dumped material.  

The site lies close to findspots for a number of prehistoric artefacts. There is also a Bronze Age 
barrow located 900m west of the site which is a scheduled monument. There are also cropmarks 
associated with prehistoric enclosures close to the proposed development area.  

The site lies close to the line of two Roman roads, the Mancetter Road and Watling Street. 
Roman settlement remains have been found to the north-east of the site with further findspots 
from the Roman period nearby. 

There are two deserted medieval villages in the vicinity of the site (Lindley and Rowden). The 
remains of the chapel at Lindley Park are also scheduled monuments. 

The site of the Battle of Bosworth (1485) lies to the north-east of the proposed area and both 
the proposed area and the MIRA site lie partially within the area designated as the extent of the 
battlefield. A large amount of medieval finds have been discovered from the battlefield 
including a halberd, cannonballs, badges and rings. Some finds have been located within the 
proposed area.  

Features associated with the site’s former use as an airfield have been located during previous 
archaeological work. 

Therefore there is moderate potential for archaeological remains and finds from prehistoric, 
Roman, medieval and post-medieval and modern periods to be revealed during the proposed 
new development on the site. There will be an impact on the setting of the battlefield as well 
as a direct impact from the new development on the part of the battlefield that lies within the 
proposed development area. 

4. Geophysical Survey 
 

A geophysical survey was undertaken for ULAS by Stratascan Ltd (Gater 2018). No responses 
of archaeological interest were recorded and no burial pits associated with the Battle of 
Bosworth were identifiable. Features related to the WWII airfield were mapped as were former 
field boundaries, ridge and furrow cultivation patterns and several service pipes. 

5. Aims and Objectives 
 

The overall aim of the survey was to accurately record the location and state of preservation of 
surviving earthwork features within and immediately adjacent to the site in order that their 
significance could be assessed.  

Objectives included 

• Defining the extent of positive (bank) and negative (ditch) features within the 
proposed area 

• Defining the extent of positive (bank) and negative (ditch) features within the 
MIRA site with particular consideration of the airfield history of the site 
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• With reference to the Geophysical Survey identify common features within the 
proposed area possibly enable further interpretation 

• Review the topographic location of the site in order to understand the landscape 
context of features identified. 

 

Research Aims 
The initial assessment suggested that archaeological work would be able to contribute towards 
several research objectives derived from The Archaeology of the East Midlands: An 
Archaeological Resource Assessment and Research Agenda (Cooper 2006) and East Midlands 
Heritage: An updated research agenda and strategy for the Historic Environment of the East 
Midlands (Knight et al. 2012). 

The archaeological evaluation was identified as having the potential to contribute to the 
following research aims. 

The Medieval period (Vince 2006, Lewis 2006, Knight et al 2012; English Heritage 2012). 

The study has the potential to contribute towards research into the origins and development of 
medieval settlement, landscape and society. The work has the potential to contribute to 
Research Agenda topics 7.1.2, 7.1.4, 7.2.1-7.2.4, 7.3.1-7.3.5, 7.5.4, 7.6.1-2, 7.7.1-7.7.5 and 
Research Objective 7E - Investigate the morphology of rural settlements. 

Modern (1750 to Present) 
The work can also contribute to Research Agenda topic 9.8 Military sites: Can we establish a 
typology of surviving post-1750 military remains? How are military sites distributed across the 
region? What impacts have military developments had upon settlement development, 
landscapes, industry and transport? 
 

6. Methodology 
Analysis based upon aerial LiDAR data was requested by the Leicestershire County Council, 
Principal Planning Archaeologist, as archaeological advisor to the planning authority. 
Following a search of Environment Agency archived data, aerial LiDAR data at 1m resolution 
was downloaded in ASCII file format from the Open Data web portal 
(http://environment.data.gov.uk/ds/survey#/download?grid=SP70). 

The LiDAR data had been collected in 2013: details of the data source are given on page 29. 
As the study area was mostly clear of trees, the data was acquired in both DSM unfiltered and 
DTM filtered format. The filtered data has had obstructions such as buildings and vegetation 
removed to and provide a 'bare-earth' model. If the removal of any obstruction left a gap in the 
surface data this gap was interpolated by the EA (using an undisclosed algorithm) to provide a 
continuous surface. Although this data is very useful to identify potential features in woodland, 
the data in open areas can lose clarity. 

The methodology used followed that set out by Hannon (Hannon et al 2014, 8) with some 
modification.  

http://environment.data.gov.uk/ds/survey#/download?grid=SP70
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LiDAR ASCII Data Processing 

Most operations were conducted in Esri ArcMap10.3 SP1 build 3143. The Relief Visualisation 
Toolbox which enables the rapid output of multiple hillshade, slope analysis, relief model and 
sky view analysis was also used (Zakšek et al. 2011; Kokal et al. 2011). 

Data files were imported into ArcGIS using the ASCII to Raster function (System 
Toolboxes>Conversion Tools>To Raster>ASCII to Raster), the output data type was set to 
‘Float’ and the original ASCII filename was retained as the output raster name. These files 
were placed in a newly created file geodatabase called ‘15710_MarketHarborough.gdb’.  

Creation of Hillshade layers 

To aid feature identification, four basic hillshade layers were generated for each LiDAR flight.  
‘Hillshades’ are a data processing method available in most GIS which allow an artificial sun 
to be shone from any chosen compass bearing and from angle above the horizon onto a DEM. 
This process helps identify ground features by casting an artificial shadow behind changes in 
elevation (for a full discussion of the process see Bewley et al 2005). 

Each of these layers were created using the hillshade function (System Toolboxes>Spatial 
Analyst Tools>Surface>Hillshade). The input raster for each hillshade was the DTM or the 
Clipped DEM if one was generated, for each LiDAR flight. Three basic parameters were 
utilised to generate the four different hillshade views and Z factor relating to the degree of 
exaggeration applied to the input DEM, with 1 indicating no exaggeration. 

Each output raster was named to preserve the original input DEM information and include the 
hillshade parameters (e.g.‘Sitename_1mDTMHS315451’) and saved to 
‘JobCode_and_Sitename.gdb’. Once each hillshade was generated they were grouped within 
the TOC to aid navigation. 

Automatic multiple hillshade using the Relief Visualisation Toolbox (no of directions 16, sun 
elevation angle 30o ) were also created and saved to the Geodatabase 
(SP7288_DTM_1M1_MULTI_HS_D16_H30_RGB).  

Sky-View Factor Analysis  
‘Sky-View Factor’ (SVF) analysis was also applied to the LiDAR data (Zakšek et al 2011). 
This method, instead of applying false shadows to a surface, calculates the volume of sky 
visible from a given position, a position at the bottom of a ditch affords a lower level of 
visibility to one atop a mound. This method produces a raster layer showing the volume of sky 
visible from each position within the raster which can highlight subtle archaeological features. 
SVF is not a function available in ArcMap, therefore a free to use version of the tool is available 
online (http://iaps.zrc-sazu.si/index.php?q=en/svf). 

To utilise the tool the DEM for the area was exported as a TIFF. This was achieved by right-
clicking on the DEM layer within the TOC (Data>Export Data) selecting a destination for the 
TIFF file and leaving all other parameters at default. Once the TIFF had been exported the SVF 
tool was run. The exported TIFF was used as the input DEM and Search Radius was left at the 
default 10. The Vertical exaggeration was set to either 1, 2 or 3 and Direction set to either 16 
or 32, multiple Sky-Views were run for each focus area using a range of values. The tool 
created an output TIFF file which reflected the name of the input DEM and settings used (e.g. 
‘LiDAR_1m_SVF_d32_r10_ve3’). This TIFF was then imported into ArcMap and added to 
the TOC. 

http://iaps.zrc-sazu.si/index.php?q=en/svf
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The SVF images were then also interrogated and potential features recorded in the same 
manner as is detailed above for the initial feature identification process. 

Feature Identification 

The hillshade layers that had been generated were systematically analysed for potential 
archaeological features, working from north to south and west to east. This was achieved by 
working through each of the hillshade and Sky View Factor layers individually. The shapefile 
layers containing both the HER and scheduled monument data were enabled to prevent re-
identification of an already recorded archaeological feature.  

Once the areas of ridge and furrow within the study area had been identified as part of the 
LiDAR analysis, the hillshade plots that contained the clearest representations of the different 
elements were combined using varying transparencies to produce figures contained in this 
report. 

Profiles 

Profiles were generated with ARCGIS from the DTM data using the 3d Analyst tool, 
Interpolate line, choosing the profile line and Profile Graph options.  

Images were processed in Standard Raster image and CAD packages. 
 

6. Results         (Figure 10 and Figure 12) 
 
The site was visited on 26/3/2018 and the study area walked over. A number of anomalies 
identified within woodland to the immediate north-east of the airfield were positively 
identified as vehicle testing tracks. 
 

• Preservation of surface features across the area is poor.  
• Ridge and furrow earthworks can be identified in the north of the area immediately south of 

Fenns Lane (Figure 7, A) 
• Immediately outside the proposed area on the east side, two parallel positive linear features up 

to 150mm in depth and 160m in length and 30m apart, are aligned with the southeast-northwest 
airstrip, and may be an extension of the strip (Figure 7, Figure 10, B) 

• A slight bank feature in the north of the area is probably a post-medieval field boundary as it is 
represented by a line of trees in the 1st edition mapping (Figure 10, C). 

• To the north of Fenn Lanes, a line of poorly defined negative anomalies at 95-100m centres can 
be identified in some of the data plots. These cannot be matched with the location of ponds in 
historic mapping (Figure 12, D).  

• A second north-south bank feature less than 100mm in depth and broadly parallel with the bank 
at ‘C’ can be traced in the south-east of the northern area (Figure 10, E).  

• Immediately adjacent with the possible bank feature are two poorly defined negative features 
that cannot be matched with the location of ponds on historic mapping (Figure 12, E). 

• An area of disturbance can be identified in the area of buildings thought to be in military use 
and related to the airfield, to the immediate north of ‘The Mount’ (Figure 10, F and Figure 14) 
and also in the vicinity of farm buildings recorded in the 1st edition mapping (Figure 10, G).  

• Various paths and tracks can be traced that be identified in other sources and are of 19th or 20th 
Century date (Figure 10, H, I, J). 

• The area of woodland ‘Ashpole Spinney’ increases in its size following 1st edition mapping 
(Figure 16) 
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Figure 5: Digital Elevation Model generated from 1m DTM (filtered) date 
Lidar source Environment Agency 2018 
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 Figure 6 Digital Elevation Model of unfiltered 1m DSM aerial Lidar 
Lidar source Environment Agency 2018 
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 Figure 7: Results of LiDAR assessment showing Principal Component Analysis plot of 1m 
DTM data.  

Lidar source Environment Agency 2018 

A 

B 
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Figure 8: Results of LiDAR assessment showing Slope Analysis plot of 1m DTM data. 
Lidar source Environment Agency 2018 
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Figure 9: Results of LiDAR assessment showing Multi Hillshade Analysis plot of 1m DTM 
data. 

Lidar source Environment Agency 2018 
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Figure 10: Results of LiDAR assessment showing Multi Hillshade Analysis plot of 1m DTM 
data along with interpretations, and 1st edition Ordnance Survey mapping (1888) and 
transcription of structures visible around ‘The Mount’ in the west of the area, in a 1944 
Aerial Photograph. Lidar source Environment Agency 2018 
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Figure 11: Results of Lidar assessment showing Slope analysis of DTM overlying DTM 
Digital elevation model, alongwith area of alluvial sediments. 

Lidar source Environment Agency 2018 
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Figure 12: Results of LiDAR analysis showing shallow slope plot of 1m DTM and negative 
features that are not present in historic mapping  

Lidar source Environment Agency 2018 

D 

E 
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Figure 13: 1944 Aerial Photograph alongwith Geophysics interpretation and LiDAR 
interpretation.  
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Figure 14: Detail of probable barracks visible in 1944 aerial photograph to west of the 
proposed area to the north of ‘The Mount’ (MLE3297), and buildings recorded in the 1888 

1st edition Ordnance Survey in the west of the proposed area. 
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 Figure 15: Composite image showing Eagle’s map with field names, landuse datasets from 
the Bosworth Battlefield project for the area to the east of the proposed area, and possible 
LiDAR features, above a shade plot of the LiDAR DTM.  
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Figure 16: Current mapping above with 1st edition Ordnance Survey below showing Ashpole 
Spinney has been extended south from a much smaller area of woodland in the later 19th or 
earlier 20th Century. 

Contains OS data © Crown copyright [and database right] 2018 
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Figure 17: 1m coloured contour plot generated from 1m DTM LiDAR of the proposal area in 
relation to the registered battlefield and previous finds of archaeological material relating to 
the Battle of Bosworth 1485, and a Civil War skirmish. Contours span range between 75m 

120m aOD.  
Lidar source Environment Agency 2018 

Bosworth Battlefield Project data from ADS: https://doi.org/10.5284/1019859 
 
  

https://doi.org/10.5284/1019859
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Historic Land Use          Figure 15 

Eagle’s map of 1807 has been georeferenced into a GIS with the LiDAR data and the field 
names have been transcribed. Field names can be identified for all the proposed area bar that 
which falls in Witherley Parish as the 1807 did not extend into this area. 

The Historic Land-use data created as part of the Bosworth Battlefield project and archived 
with the Archaeological Data Service (https://doi.org/10.5284/1019859) has been downloaded 
and is shown here. 

To the east of the proposed area in the north lies land that is cultivated with strip fields at some 
stage: the finding of ridge and furrow across the proposed area to the west of this, to the 
immediate south of Fenns Lane is consistent with this data, and it is likely that all the fields in 
this area adjoining Fenns Lane on the south side, were in use for arable cultivation at some 
stage. 

The historic use of the land to the north and south of the stream that bisects the area is much 
less clear. To the east are areas of meadow/pasture/uncultivated land. No strong signatures for 
strip cultivation have been identified in the adjacent part of the proposed area although there is 
suggestion of surviving strips to the immediate north of the stream/alluvial deposits in the 1944 
aerial photo (Figure 13).  

A fieldwalking survey has been undertaken across the available fields within the proposed area 
(Gonzalez Rodriguez 2018) during which very small quantities of medieval pottery were 
recovered. 

Heath is identified in a number of field names to the east of the proposed area and across the 
central part of the MIRA site (Figure 15). This heathland has been shown to continue to the 
north-east and to extend to Fen Hole (Foard and Curry, 2013, Fig 8.2). Skirting the northern 
edge of the heath, and in the area of alluvial soils, is Meadow (Foard and Curry, 2013, Fig 8.2 
and Figure 15). 

Parkland (Little Park, Middle Park, and Further Park) is evident from field names to the west 
of the proposed area in the north. Presumably these areas were used as Deer Parks and were 
part of Lindley Hall, and did not fall within the Open Fields of any of the surrounding 
villages/townships. 

To the east and south of the parkland, the field names indicate small enclosures – Old Barn 
Close, Old House Close, Long Close with other Closes to the east of the proposed area 
indicating ‘Brick Kiln Close’ and ‘Charcoal Close’.  

7. Discussion.  
The landscape is broadly flat although the ground rises to the west, and a clear north-south 
ridge lies outside of the proposed area.  

Preservation of earthwork features across the proposed area is poor. Features that can be 
identified include  

A: the vestiges of medieval ridge and furrow in the north of the area (Figure 7 and Figure 10). 

B: Possible traces of the airfield to the east of the proposed area, although these do not continue 
into it (Figure 7 and also Figure 13, 3) 

https://doi.org/10.5284/1019859
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C: An eroded bank feature in the south-west of the northern area is probably a post-medieval 
field boundary. 

D: The area in general is notable for the number of ponds most of which can be identified in 
historic mapping. A line of six poorly defined negative features at between 95 and 100m 
spacings can be identified in the fields to the north of Fenn Lanes (Figure 12) which do not 
relate to mapped ponds. It is tentatively suggested that these may be the result of WW2 
bombing, although a recent report addressing the potential for unexploded ordnance in the 
proposed area concludes the presence of unexploded ordnance within the proposed area as 
unlikely, as ‘no available evidence indicates any bomb damage within the site or its immediate 
surrounds’ (1st Line Defence, 2018, pIII). 

E: Two similar anomalies are interpreted within the proposed area in the southeast of the 
northern area (Figure 12). These also correspond with anomalies in the geophysical data, and 
dark marks in the 1944 aerial photograph (Figure 13). The features may be ponds that have not 
been recorded in the mapping consulted or may be bomb craters. 

F: From a 1944 Aerial photograph, and the 1964 Ordnance Survey Historic Mapping, a series 
of buildings, probably barracks, are visible to the west of the proposed area, to the north of 
‘The Mount’. 

G: The current area of Ashpole Spinney is created subsequent to the 1888 first edition Ordnance 
Survey mapping. 

H, I, J: A number of trackways and paths can be identified. These can all be related to historic 
documentary/photographic sources. 

Relationship with the 1485 Battlefield 
The area lies at the southwestern end of the registered battlefield. There is a topographic change 
from lower lying land to the east, to higher ground to the west which forms a north-south ridge: 
this higher ground would surely have provided a vantage point over the battlefield presumably 
to the advantage of Henry whose army approached from the west (Foard and Curry, Fig 8.1, 
p180).  

A mound has been constructed on the apex of the ridge and is assumed to be a post-medieval 
feature within Lindley Park. 

Some subtle breaks of slope within the proposed area can be identified by widening of contours. 

8. Conclusion 
Assessment of 1m aerial LiDAR elevation data using a number of analytical techniques has 
demonstrated that the preservation of earthwork features in the proposed area is generally poor. 
Linear features that can be identified can be traced in historic mapping or aerial photographs 
and shown to be either previous field boundaries, or tracks. 

Medieval ridge and furrow can be traced in the north of the proposed area and the location of 
these furlongs is broadly consistent with the medieval land-use researched for the Bosworth 
Battlefield Project. Medieval and early Post Medieval land-use in the central part of the 
proposed area is unclear: to the immediate east is heath and some meadow, and to the 
immediate west, enclosed park land. The lack of identifiable ridge and furrow in this central 
area, and a low level of finds of medieval pottery from a fieldwalking survey (Gonzalez 



Land at MIRA, Higham on the Hill  Report 2018-054 

© ULAS 2018   26 

Rodriquez 2018) might indicate that this area is not cultivated land in the medieval period and 
it extends the uncultivated areas of meadow and or heathland known to have existed to the east. 

The area is striking for the number of ponds which can found serving most fields, the 
majority of which are recorded in historic mapping.  

Two slight depressions in the southeast of the northern area are of unknown origin. These 
correspond with areas of disturbance in the geophysical survey interpretation, and also two 
marks in the 1944 aerial photograph.  

Traces of bank features some 30m apart, aligned with the southeast-northwest landing strip are 
identified in the LiDAR and in the geophysical survey to the east of the proposed area. These 
are interpreted as part of the airfield’s layout. 

The broad topography is flat although there is a general slope down to the east. On the western 
edge of the proposed area the slope is more marked, with elevated ground forming a low broad 
north-south ridge to the west of the proposed area.  
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12. Appendix 
 
 
LiDAR tiles  processed for this report: 
 

OBJECTID FILENAME TILENAME DATE_FLOWN PERCENT_CO POLYGON_ID RESOLUTION 
120540 D0161103 SP3496 4- 6 Feb 2013 99.99 P_8705 1 
120541 D0161104 SP3498 4- 6 Feb 2013 99.99 P_8704 1 
120552 D0161115 SP3696 4- 6 Feb 2013 99.9 P_8705 1 
120553 D0161116 SP3698 4- 6 Feb 2013 99.95 P_8704 1 
120566 D0161129 SP3896 4- 6 Feb 2013 98.91 P_8704 1 
120567 D0161130 SP3898 4- 6 Feb 2013 99.83 P_8704 1 
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